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1. Clearing Participant - ETD only

1.1. Introduction

1.11.  Purpose of ASX Clear (Futures) Static Data Portal

ASX Clear (Futures) Static Data Portal (SDP) is a web based system that provides Clearing
Participants the access to directly enter and update Static Data used within the clearing process
for Exchange Traded Derivative (ETD) products. This Static Data includes but is not limited to,
Client Accounts and Clearing Participant Entities and Standard Settlement Instructions.

1.1.2.  Audience for this Manual

The ASX Clear (Futures) Static Data Portal User Manual has been written for ASX Clear (Futures)
Clearing Participants. The Clearing Participants users of the ASX Clear (Futures) Static Data
Portal include:

Clearing Participant Administrator User
Clearing Participant Submitter User

Clearing Participant Approver User

This user guide covers the following subject areas:

1

~N o O A W N

)
)
)
)
)
)
)
)

8

Introduction and system overview

User access and administration functionalities
Client Clearing Account Structure

Workflows and Actions

Approvals and Rejections

Static Data Portal Web Pages

FAQs

Contacting ASX Support

© Copyright 2014 ASX Limited ABN 98 008 624 691. All rights reserved 2014 4,
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1.2. Setup and Access

1.21.  System Setup
To access the ASX Clear (Futures) - Static Data Portal, you need to have the following:
¢+ Internet Explorer 7, 8 or 9.
+  JavaScript enabled browser
+  ActiveX Controls set to “Enabled”

+  Onsite MSI package installed for Windows XP Operating System

1.2.2.  Accessing ASX Clear (Futures) - Static Data Portal

Open your browser and navigate to https:/asxstaticdata.connect.asxonline.com

In order to log in to the Static Data Portal you will need to have the following:
+  An Active ASX Online user profile (user name and password)

+ Anenrolled and installed Digital Certificate supplied by ASX

*  Relevant User profile set up in the SDP.

See 2.4 User Access for more details on obtaining the above and logging into the SDP

1.2.3.  Session Timeout

Session timeout and disconnection occurs after 60 minutes of inactivity and any unsaved
information will be lost. To continue using the ASX Clear (Futures) — Static Data Portal you are
required to log in and authenticate again.

1.24. Changing your password

Passwords to use the ASX Clear (Futures) service are the same as the password used to access
the ASX Online service. If you are given an ASX Online password for the first time, you will need
to change that password initially in ASX Online before trying to login to the ASX Clear (Futures)
Static Data Portal. ASX Online passwords expire every 45 days and you will be prompted by the
system to create a new password. If your password has expired, a message will be displayed
when you next attempt to log in to ASX Clear (Futures) Static Data Portal. You will not be able to
log in until you have changed your password. All password changes are conducted through ASX
Online.

To change your password, follow the prompts presented to you on screen. Please note: the
following requirements must be met when setting your password:

1. Passwords must contain characters from at least three (3) of the following four (4) classes:
*  English upper case letters, i.e. A-Z
+  English lower case letters, i.e. a-z
*  Numeric Values, i.e. 0-9
+  Non-alphanumeric special characters of: $ (dollar sign) or _ (underscore)
2. Passwords may not contain the username or any part of the user’s full name
3. Passwords must be between 8-12 characters long

4. New passwords must not be the same as the previous password

1.3. Operating Hours
The ASX Clear (Futures) Static Data Portal is available to users 24x7 365 days per year.

© Copyright 2014 ASX Limited ABN 98 008 624 691. All rights reserved 2014 5.
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& Note:

Changes to Static Data will not be reflected in daily EOD Static Data Reports unless the
change was made and approved prior to 6pm AEDST Mon — Fri. Changes made outside of
these hours will be reflected in Static Data Reports available at the end of the next business
day.

User Accessibility

The first user(s) at any Clearing Participant will need to be set up by the ASX as a Clearing
Participant Administrator User (see section 2.4.1.1 Clearing Participant Administrator User Set Up
for details on how to do this). This Administrator User will then be able to create and update
further users (Clearing Participant Administrators, Submitters and Approvers)

Creating Users

The ASX Clear (Futures) — Static Data Portal uses user types and permissions to control access.
There are three user types associated with the portal, namely:

1. Clearing Participant Administrator — This user controls the right to assign user
permissions for the Clearing Participant. This user can assign a user against either:

«  Clearing Participant Administrator
«  Clearing Participant Submitter
«  Clearing Participant Approver

2. Clearing Participant Submitter — This user can enter and submit static data information for
approval.

3. Clearing Participant Approver — This user reviews and either approves or rejects static
data submitted by the Clearing Participant Submitter.

Section 2.5.1 provides step by step instructions on how the Administrator Users can create further
user profiles within the SDP.

Note: More than one user role can be assigned against a user by the Clearing Participant
Administrator. Where a user has been assigned against a Clearing Participant Submitter and
Clearing Participant Approver role, that user cannot approver his/her own work.

1.4.1.1. Clearing Participant Administrator User Setup

To create an ASX Clear (Futures) Static Data Portal Clearing Participant Administrator User, you
should:

1. Ensure you have an active 'ASX Online profile: Contact ASX Online Help Desk

2. Complete, scan and email the following form to: asxclearfutures@asx.com.au

3. Receive Clearing Participant Administration User credentials from ASX Clearing Operations
by email

4. Enrol and Download Digital Certificate - Digital Certificate Procedures

5. Confirm login at the following link: https://asxstaticdata.connect.asxonline.com

1 Users must login to ASX Online and change their password to activate their account

© Copyright 2014 ASX Limited ABN 98 008 624 691. All rights reserved 2014 6.
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8

Tip:

If a user setup by a Clearing Participant administrator is unable to access the ASX Clear
(Futures) Static Data Portal, they can refer to the Appendix 3: Troubleshooting.

Appendix 3: Troubleshooting highlights three most common areas that can prevent users
from accessing ASX Clear (Futures) Static Data Portal:

«  Browser Related Issues
+ Digital Certificate Issues

+  Static Data Portal Access Issues.

1.4.1.2. Clearing Participant Submitter / Approver Setup

To create an ASX Clear (Futures) Static Data Portal Clearing Participant Submitter or Approver
role, you should:

1. Ensure you have an active2 ASX Online profile: Contact ASX Online Help Desk

2. Ask your Clearing Participant Administrator to create a Clearing Participant User profile and
request a Digital Certificate — refer to Administration Functionality

3. Enrol and Download Digital Certificate - Digital Certificate Procedures

4.  Confirm login at the following link: https:/asxstaticdata.connect.asxonline.com

2 As per foot note 1

© Copyright 2014 ASX Limited ABN 98 008 624 691. All rights reserved 2014 7.
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1.5. Administration Functionality

The Administration functionality of the ASX Clear (Futures) Static Data Portal enables a Clearing
Participant Administrator to:

*  Create,
+  Edit, and
* Disable

1)  Clearing Participant Administrator user accounts
2)  Clearing Participant Submitter user accounts

3) Clearing Participant Approver user accounts

1.5.1. Create a new user

1. Create a new user by first clicking on the ‘User Management' link in the navigation panel on
the left hand side of the screen. The User Management Search screen will appear as per
below:

ASX Clear (Futures) Static

User Management Click on the menu item on the left to go to the area you wish to use.
Search

Add new Client Account

2. Click on the ‘Create New User’ button.

ASX Clear (Futures) Static Data Portal

‘Welcome: Jeff Wiggles | Role: CP Administrator, CP Submitter | H

User Management User Management
Add new Client Account User Search
Firm Code: Username:

3. Clearing Participant Administrators will be able to search for usernames that have already
been set up in ASX Online against their Firm. ASX Online usernames are case sensitive.

ASX Clear (Futures) Static Data Portal

Welcome: Jeff Wiggles | Role: CP Adi

User Management Create New User
Search User Details
Add new Client Account
AOL User Name: Search AOL Users

4. If a match is found, the following details will be populated:

© Copyright 2014 ASX Limited ABN 98 008 624 691. All rights reserved 2014 8.
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+  ASX Online User Name

¢+ First Name

+  LastName

¢+ Email Address

+  Firm Code
5. Input a relevant Contact Number for the Clearing Participant User
6. Nominate one or more user roles :

«  Submitter

+  Approver

Clearing Participants have the ability to manage their own Users and User privileges. Request a
digital certificate on the user's behalf, by checking ‘Request Certificate’ and click “Create User” to
apply changes. This will send a request to ASX Online Help Desk who will provide a VeriSign digital
certificate to the User.

7. Click the ‘Close’ button to end the user creation process.

1.5.2. User Search

ASX Clear (Futures) Static Data Portal

Welcome: Jeff Wiggles | Role: CP Administrator, CP Submitter | Firm: CXI

User Management User Management

Add new Client Account User Search

Firm Code: Username:

Contact Number

cba_sub Jeff Wiggles CXL  Jwigglestest@asx.com.au True CP Administrator, CP Submitter

damu3o oMy MOS30 CXL  dmu30test@asx.com.au True CP Appraver

1. Go to the ‘User Management’ screen.
Input the Username.

Click ‘Search’

el

Results will appear in summary form

1.5.3. Edit User

1. Locate the Clearing Participant User in question as per User Search

2. Click on the Clearing Participant User in the search results

3. Make the following changes as appropriate:
*  Roles — Submitter/Approver
*  Revoke Certificate — Send request to ASX Online Help Desk
*  Request Certificate — Send request to ASX Online Help Desk

*  Activate or Disable User Access

© Copyright 2014 ASX Limited ABN 98 008 624 691. All rights reserved 2014 9.
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1.6. Client Clearing Account Hierarchy
Within the Static Data Portal there are two entity types:

Clearing Participant Entity (Level 1) - this is set up by the ASX prior to the CP on-boarding. All
Clearing Participant details such as ABN, LEI, Address, Contact Details are appended to the
Clearing Participant Entity by the ASX. A unique 3-digit Clearing Participant code is assigned to
each CP Entity. See section 2.10 Clearing Participant Entity Records for more details.

Client Entity (Level 2) — this is set up by the ASX upon request from either the CP or the Client
Directly. In order to set up a new Client entity the Client (or the Clearing Participant on behalf of
the client) must fill in and submit to the ASX the Client Entity Configuration Form. A unique 3-digit
Client code is assigned to each Client Entity.

The following diagram illustrates the relationship between each Entity type record for Clearing
Participant and Clients that can clear across Futures only. For reference, the following conditional
terminology is used:

1:1=1and only 1 Entity record is associated with its related Entity partner.

0: * =0 to many Entity records are associated with its related Entity partner.

In order to read the diagram, apply the condition at the arrow pointing away from the Entity that
you wish to map the relationship for.

l.e. a Clearing Participant can have 0 : * Client Accounts associated with it.

Clearing
Participant
Entity
1:1
Level 1
0:*
0:1 0:* :
. . Client
Entity C--m-mmmmemmmmmamacaaad
Client Entity ¢ > P
Level 2

Exceptions to the rules above include:

- AFutures House Participant Entity will not be managed within the Static Data Portal

- AClient Account that has been configured as an Omnibus Account will not be associated with
a Client Entity.

© Copyright 2014 ASX Limited ABN 98 008 624 691. All rights reserved 2014 10.
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- Book / Funds will not be associated with a Futures Client Account as all positions will be
allocated to the Client Account.

- AFutures Client Account cannot be configured as an Omnibus Account. The creation and
allocation of Omnibus Client Accounts will be as per the existing configuration and allocation
process within Secur / Genium.

1.7. Workflows Status & Action States

In order to create or edit existing records within the Static Data Portal, a workflow approval process
is enforced to ensure that data is verified and validated prior to being deployed.
The following workflow status states are assigned by the system based on the action performed by
a Clearing Participant user.
User Role who
Action Status can perform Rules
action

Save Saved Submitter The record has been saved to the system but has not yet been
deployed
Mandatory and functional field validation rules are not applied
when saving a record into the system
A Submitter user can save a record into the system
An Approver user does not have the ability to approve or reject
records that have a status of ‘saved’

Cancel Deleted Submitter A record that is currently in the process of being created, but is
not yet approved can be deleted from the system. The delete
can only apply from the saved state
The edit performed against an Approved record can be deleted
from the system. The delete can only apply from the saved
state
A deleted record cannot be viewed or retrieved at a later date

Submit Submitted Submitter The record has been submitted for approval by the submitter
user
Mandatory and functional field validation rules are applied when
submitting a record in the system
An Approver user will have the ability to approve or reject
records that have a status of ‘submitted’

Approve | Approved Approver The submitted record has been approved by the Approver user
and is now deployed to the system

Or
Where the record submitted (CP Submitted) for review and
approval by the ASX was approved

© Copyright 2014 ASX Limited ABN 98 008 624 691. All rights reserved 2014 11.
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User Role who
Action Status can perform Rules
action
Reject Rejected Approver The submitted record has been rejected by the Approver user
and will be available to be amended prior being either re-
submitted or deleted from the system by the Submitter user
Where a record has been rejected a Reject reason will need to
be appended to the record
Approve | CP Submitted | ASX User The CP Submitted status will be triggered where the Clearing
Participant has attempted to make a Client Account Inactive
from either an Active or Hold State
Reject ASX Reject ASX User The CP Submitted record has been reviewed and rejected by
the ASX. The record can be amended prior to being either re-
submitted or deleted from the system by the Participant
Submitter user
Where a record has been rejected the ASX will append a Reject
reason to the rejected record
1.8. Approved Status States
Once a record has traversed through the workflow approval process, an approved status will be
assigned to the record.
The approved status represents the end / deployed state of the record and can be one of the
following:
Status Description Rules
Active The record is active within the | All active records associated with the Clearing Participant users
system Firm code can be viewed within the system
Inactive | The record is not active within | As a Clearing Participant user, a Client Account as well as the
the system Book / Funds associated with the Client Account can be made
Inactive
As a Clearing Participant user, any Client Accounts set to Inactive
can still be viewed within the system
Hold A Hold status can be In a default scenario where the Client has defaulted, as a

representative of a number of
scenarios where no action can
be taken against the record.
Hold is applicable in the
scenario where the Client Entity
has defaulted

Participant user the Client Account can be set to Hold.

As a Clearing Participant user, any Client Accounts set to Hold can
still be viewed within the system

© Copyright 2014 ASX Limited ABN 98 008 624 691. All rights reserved 2014
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Status Description Rules
Pending | A Client Entity record is neither | Where a Client Entity has been set to Pending, Client Accounts

active nor inactive within the
system and is in the process of
being setup and configured prior
to being made Active for
trading. Therefore Client
Accounts and Book / Funds can
be created against the Client
Entity but only in a Pending
status.

records created against the Client Entity can only be created in a
Pending status

Once the Client Entity has been set to Active, all Client Accounts
records associated with the Client Entity will be set to Active
automatically

As a Clearing Participant user, Client Accounts set to Pending can
still be viewed within the system against the Pending Client Entity

A record cannot be set to Pending once it has become Active
within the system

© Copyright 2014 ASX Limited ABN 98 008 624 691. All rights reserved 2014
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Record Search Page

Once login and authentication is successful for the Static Data Portal the Clearing Participant User
will be presented with the Record search Page.

The record search page allows a user to search for:
- Clearing Participant details associated with their Clearing Participant Entity Code

- Client Account details associated with their Clearing Participant Entity Code

The Record Search Page has been divided into the following components:

Quick Search Search Criteria

Search Results

1. Quick Search

2. Search Criteria

3. Search Results

The following sections provide information on how to retrieve information stored within the Static
Data Portal using each of the above components.

Quick Search

The Quick Search pane allows a Clearing Participant user to quickly return records within the
Search Results pane without the need to specifically enter Search Criteria

Quick Search

User Management
Search for Saved Records
Search

Search for Submitted Records

Add new Client Account
Search for Rejected Records

Search for CP Submitted Records

Search for All ASX Rejected Records

© Copyright 2014 ASX Limited ABN 98 008 624 691. All rights reserved 2014 14.
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The following quick search links are available along with the associated description:

Quick Search Description

Search for all Saved Records Return all Saved Records associated to the Clearing Participant User

Search for all Submitted Records | Return all Submitted Records associated to the Clearing Participant User

Search for all Rejected Records Return all Rejected Records associated to the Clearing Participant User

Search for all CP Submitted Return all CP Submitted Records associated to the Clearing Participant User
Records
Search for all ASX Rejected Return all ASX Rejected records associated to the Clearing Participant User
Records

& Note:

Results returned as a result of a quick search link will be displayed irrespective of the
Account hierarchy structure and will be grouped based on the entity structure as follows:

- CP Entity
- Client Entity

- Client Account

1.9.2.  Search Criteria

The Search Criteria pane allows a Clearing Participant User (Submitter / Approver) to specify
individual search criteria to return specific search results.

Multiple search criteria fields can be combined in order to further restrict or confine the search
results returned.

A description of the individual search criteria fields applicable within the Static Data Portal are
defined below:

Quick Search Field Type | Description Application

Clearing Drop Down | This will be locked to the Firm code When used in isolation, all records
Participant associated with the Clearing associated with the Firm code will be
Code Participant User Id returned in the search results pane

© Copyright 2014 ASX Limited ABN 98 008 624 691. All rights reserved 2014 15.
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Quick Search Field Type | Description Application
Client Entity Drop Down | All Clients associated with the Where a Client Entity Code has been
Code Clearing Participant Firm will be selected from the drop down list, the
visible within the dropdown list Client Accounts associated with that
. , specific Client Entity Code will be
Wr|1ere j fCIlenthEnélty hgs be?,” returned in the search results pane
selected from the drop down list, along with the Parent information
- Client Entity Name
- ABN
-LEl and
- Company Registration Number
fields cannot be edited
Client Entity Free Text A search can be performed on a A Client Entity Name can be entered
Name Client Entity Name as text without wildcard characters or
with wildcard characters added.
Wil h include:
Where a Client Entity Code has been ld card characters include
selected, the Client Entity Name is * = matches zero or more characters
returned and cannot be edited
v ! Client Accounts matching the Client
Entity Name text string entered will be
returned in the search results pane
along with the Parent information
Client Entity Number A search can be performed on an Client Accounts matching the Client
ABN ABN assigned against a Client Entity. | Entity ABN entered will be returned in
the search results pane along with the
Parent information
Where a Client Entity Code has been
selected, the Client Entity ABN
cannot be edited
Client Entity Free Text A search can be performed on an Client Accounts matching the Client
LEI LEI assigned against a Client Entity. Entity LEI entered will be returned in
the search results pane along with the
Parent information
Where a Client Entity Code has been
selected the LEI cannot be edited
Client Entity Free Text A search can be performed on an Client Accounts matching the Client
Company Company Registration Number Entity Company Registration Number
Registration assigned against a Client Entity. entered will be returned in the search
Number results pane along with the Parent

Where a Client Entity Code has been
selected the Company Registration
Number cannot be edited

information

© Copyright 2014 ASX Limited ABN 98 008 624 691. All rights reserved 2014 16.
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Quick Search Field Type | Description Application
Client Account | Drop Down | All Client Accounts associated with Where a Client Account Code has
Code the Participant Firm will be visible been selected from the drop down
within the dropdown list list, the Client Account Code will be
) returned in the search results pane
Where a Client Account has bleen along with the Parent information
selected from the drop down list,
- Client Account Name
- Swapswire Id
fields cannot be edited
Client Account | Free Text A search can be performed on a A Client Account Name can be
Name Client Account Name entered as text without wildcard
characters or with wildcard characters
added.
Where a Client Accognt Code has Wild card characters include:
been selected, the Client Account
Name is returned and cannot be * = matches zero or more characters
dited
edre Client Account(s) matching the Client
Account Name text string entered will
be returned in the search results pane
along with the Parent information
Swapswire Id N/A N/A N/A
Book / Fund N/A N/A N/A
Code
Book / Fund N/A N/A N/A
Name
Clearing Drop Down | Options available will be either When used in isolation, all records
Participant ‘Blank’ or ‘Active’ associated with the Clearing
Status Participant will be returned
Clearing Drop Down | Options available will be either When used in isolation all records
Participant ‘Blank’ or ‘Saved’ or ‘Submitted’ or | Matching the status entered will be
Outstanding ‘Rejected returned
Actions
When combined with Clearing
Participant Status, the records
returned will act as a union / join
between the two status’
Client Entity Drop Down | Options available will be either When used in isolation, all records
Status ‘Blank’ or ‘Active’ associated with the Client Entity will
be returned
Client Entity Drop Down | This will be blank N/A
Outstanding
Actions
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from the Search result pane

Quick Search Field Type | Description Application
Client Account | Drop Down | Options available will be either When used in isolation, all records
Status ‘Blank’ or ‘Active’ or ‘Inactive’, associated with the Client Account will
‘Pending’ or ‘Hold’ be returned
When combined with  Clearing
Participant ~ Status, the records
returned will act as a union / join
between the two status’, i.e.
- Active (CP) + Active (Client
Account), will only return records
where the CP AND associated
Client Account are Active
Client Account | Drop Down | Options available will be either When used in isolation all Client
Outstanding ‘Blank’ or ‘Saved’ or ‘Submitted’ or Accounts matching the status entered
Actions ‘Rejected or ‘CP Submitted’ or ‘ASX | Will be returned
Rejected’
When combined with Client Account
Status, the records returned will act
as a union / join between the two
status’, i.e.
- Active + Saved, will only return
Client Account records that are
Active that also have a Saved
workflow appended against it.
Book / Fund Drop Down | N/A N/A
Status
Book / Fund Drop Down | N/A N/A
Outstanding
Actions
Filter Inactive Check Box Allows a user to filter Inactive records | Inactive records will be either omitted

(where check box has been checked)
or displayed (where check box has
been unchecked)
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1.9.3.  Search Results

The results of either a Quick Search or specific Search Criteria appended will be visible within the
Search Results pane.

I O I S Y R R T

(o7 [ tower | o [ Goe [ ] ComcGen | ok | N | e | Gow | Nam ] cuws Actions Date

Eexo ACTIVE Submitted - ASX 11/04/2014 09:57
NZF Client ACTIVE 24/03/2014 10:14
SFE Client ACTIVE 11/04/2014 10:00

The search results pane provides a visual representation of the Client Clearing Account Hierarchy
related to the Clearing Participant.

Each row represents a unique record within the Account Hierarchy structure

Colours are assigned to an Outstanding Action for quick identification. The colours applicable
against each Outstanding Action status are as follows:

Status Functional Rule Colour
Saved Where the record has a Workflow Status = ‘Saved’ Light Yellow
Submitted Where the record has a Workflow Status = ‘Submitted’ Light Orange
Reject Where the record has a Workflow Status = ‘Reject’ Light Red
CP Submitted | Where the record has a Workflow Status = ‘CP Submitted’ Light Orange
ASX Rejected | Where the record has a Workflow Status = ‘ASX Rejected’ Light Red

The results returned in the search result pane can be either expanded or collapsed to vary the
information returned as per the Account Hierarchy.

| comaem | omew |
| _cp | tedger | cm | Code [ NP | CapitalC Client |

Hex
= sFE Client
= MEB
MAE
A description of the individual search result fields retuned is defined below:
Search Results Description
cP Returns the Firm code associated with the Clearing Participant User Id
Ledger Returns the Ledger allocated to the Clearing Participant record. Each Ledger
will be displayed on a unique row
Clearing Type Indicates the Clearing Type Indicator (Client) assigned to the Clearing
Indicator Participant & Ledger combination
Client Entity Code Returns either the Client Entity Code (CPM Client) or Capital C Client (where
there is a Nominated Person) or a Nominated Person associated with the
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Participant.

When the mouse cursor is hovered over the Client Entity Code, the Name
assigned to the Client Entity is returned

NP Indicator for Nominated Person, can be either Y (when Client Entity has
been configured as a Nominated Person) or Blank (where a Client Entity
code has been configured as a CPM Client or Capital C Client)

Capital C Client Returns the Capital C Client where the Client Entity has been configured as
a Nominated Person

Client Account Code Returns each Client Account Code associated with the Client Entity

Client Account Name Returns the name associated with the Client Account Code

Client Account Type Returns the Client Account Type (ICA)

Book / Fund Code N/A
Book / Fund Name N/A
Status Returns the individual ‘Approval’ status associated with each record

displayed. In order to view the Approved record, the status will be
represented as a hyperlink which can be clicked to open up the page
associated with that record

Outstanding Actions Returns the individual ‘Workflow’ status and Firm who performed the last
update associated with each record displayed. In order to view the Workflow
record, the status and User Role will be represented as a hyperlink which
can be clicked to open up the page associated with that record.

Where a record does not have a Workflow status (i.e. currently in the
process of being edited or created), the field will be blank

Last Actioned Date Returns the last date and time the record was updated or modified.

In order to search for a record where specific search criteria have been appended, use the following steps:

Step | Action User Description
1. Data Entry Submitter or Select or enter criteria in the available fields within the Search
Approver Criteria pane.
2. Click ‘Search’ Submitter or
button Approver
3. View Data Submitter or Search results will be retuned based on the search criteria entered
Approver
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1.9.4. Viewing and Editing Records

Records exist within the system in either an:

- Approved state or;
- Edited/Workflow state (i.e. where a workflow status is applied)

Either state can be viewed within the system in order to allow a Clearing Participant user to view
changes currently being made to a record (where permissions allow) or at the very least allow a
Clearing Participant user to observe that changes are being made to a record by another user.

In order to view either record state, the action to do so is initiated via the Record Search page —
Search Results pane.

1.9.4.1. Viewing Approved Records

In order to view an Approved record state, the ‘Status’ column in the Search Result pane will be
populated with the Approval status applied to the record.

Clearing Participant m Client Account Book / Fund
GoprmiC Ot | o | e | e | Gow | e |

Hox

Status
ACTIVE

NZF Client

ACTIVE
B sre Client

ACTIVE

The approved record can be viewed by clicking the hyperlink in the appropriate records column.
This will bring the user to the pages related to that specific record.

Where no ‘hyperlink’ has been provided, the user does not have access to the record

1.9.4.2, Viewing an Edited Record

Records that are currently in the process of being edited (i.e. have a workflow status appended)
can be viewed via the Record Search page.

In order to identify where a record is currently being edited by another user, the ‘Outstanding
Actions’ column in the Search Result pane will be populated with:

- Workflow Status (i.e. Saved, Submitted etc)

- User Role (ASX or Clearing Participant or Client) currently in the process of making the
change

Clearing Participant m Client Account Book / Fund
(o [ e | on | cow [ ] commcoem | cow | teme | e | oo | e ]

BHex

Outstanding
Actions
Rejected - CP

Status.

ACTIVE
NZF Client ACTIVE
B sFe Client ACTIVE

The edited record can be viewed by clicking the hyperlink in the column. This will bring the user to
the pages related to that specific record

Where no ‘hyperlink’ has been provided, the user does not have access to the record currently
being edited.

1.9.4.3. View / Editing a record currently in the process of being edited

Where a record is currently in the process of being edited by another User (either an ASX User or
Clearing Participant or Client User) other than the user currently editing the record, the user logged
into the portal will not be able to edit the production / deployed or edited record.

In order to alert the user to this, a message will be appended to the record

This is currently being edited by ASXUser and the record has been locked.

There will be no option to Save or Submit the record to the system.
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s

An ASX User has the ability to complete the workflow of a Client or Clearing Participant initiated
workflow.

Note:

In order to commence editing the record again, the user who initiated the edit will need to complete
and closeout the workflow associated with the record.

Where a record is not currently being edited, the ‘Outstanding Actions’ columns will be left blank.

Clearing Participant Client Entity Client Account Book / Fund
Toager Namo oo | e | e | o | tem |

Blex

1.9.5.  Workflow Approval / Rejection Process

In order to either deploy a new record or changes made to an existing record to the system, the
record must be validated and approved by the Clearing Participant Approver.

Similarly, to prevent either a new record or changes to an existing record from being deployed, the
record can be validated and rejected by the Clearing Participant Approver. Where a Clearing
Participant Approver has rejected a record, a rejection reason must be applied to the rejected
record.

The approval / rejection process follows the ‘four eyes’ verification principle that requires validation
by a second party before changes can take effect within the system.

A user can be both an Submitter and Approver, but the user cannot Approve / Reject their own
changes.

The workflow Approval / Rejection process applies to each Entity within the system and varies
based on the Entity type and whether the record is either newly created or an edit to an existing
record. The following diagrams illustrate the workflow process for each Entity type
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1.9.5.1. Clearing Participant Entity Workflow Approval / Rejection Process

At a high level the following diagram illustrates the workflow associated with approval / rejection associated with an edit of an existing Clearing
Participant Entity record. Please note that this has not been differentiated by the Participant user role. Colours identify the workflow status
applicable:

Clearing Participant Entity — Approval Workflow Process

Save or Delete or
Submit? Submit? Submit

Save or
Submit?

= Enter CP
o i i i Saved
8 QiEdlt CP Entity Details EntifidRetails DeIete-)‘
§ Saved CP Entity record is
b Submit submit  deleted from system
© Status Legend . Yes
a Edit CP
oo = 4 Account?
& || status =‘New N»‘
= |:| Status = ‘Saved’ CP Entity record
Q A Approved
(@] - Status = ‘Deleted’ Rejected

|:| . X Approver

Status = ‘Submitted P Reviews CP Approved—}O

D Status = ‘Approved Entity Details
Approve or

- Status = ‘Reject’ Reject?
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1.9.5.2. Client Account Workflow Approval / Rejection Process

At a high level the following diagram illustrates the workflow associated with approval / rejection associated with both the creation of a new and
the edit of an existing Client Account record. Please note that this has not been differentiated by the Participant user role. Colours identify the
workflow status applicable.

Client Account — Workflow Process
Status Legend ;
l:l Status = ‘New’ Approve
l:l Status = ‘Saved’ Approve or Rejec
Reject?
- Status = ‘Deleted’
l:l Status = ‘Submitted TAAT
ASX Revi P
> l:l Status = ‘Approved Subnr:\tlz‘:s Rejection
(75} Reason to
< - Status = ‘Reject’ Changes
l:l Status = ‘CPSubmitted’
l:l Status = ‘ASXReject’
A
Save or | E:n Clletn?t
Submit? Save — ceounts A 4
.L Enter Client Approver
< Account MYes: reviews rejected
Details message
Save  save or Submit—Submit Save or N
N X o
Submit? mit?
Q Submit ubmi Submit
o i Enter Client
% Submit or €19%€ Account
o Enter Client Close? Delete or Details
© Q—Create New Client Account: Account ’ Submit? Delet:
el . ?
o Details Saved Client Account Edit Client
(== Submit record is deleted from Account? NO’O
%D system
= Edit Client &S Client Account
$ Account? record
- No Approved
© " pprov
A 4 Rejected No
‘ Approver 'Slyls;gm Ch;d(s /\ System Sends
| Reviews Client Approve! '; DLt dels > Yes P> Message Alert to
i ownstream
Account Details vetame ASX
Approve or Impact
Reject? Identified?
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1.10. Clearing Participant Entity Records

Details associated with each Clearing Participant are maintained across a number of pages
assessable by a tabbed page design layout

Clearing Participant information is associated with the following tabs:

- Details
- Contacts

1.10.1. Accessing an editing an existing Clearing Participant record

Access to existing Clearing Participant Entity information saved into the Database is via the
Record Search page.

Clearing Participant

Hess

Client Account Book / Fund Outstanding
Come [ | ComcOien | Gowe | Mame | e | oo [ W | s otions

ACTIVE

Use the following steps to access the information:

Step | Action User Description
1. Data Entry Submitter or On the record search page and within the Search Criteria pane,
Approver select the Clearing Participant Code from the drop down list
2. Click ‘Search’ | Submitter or
button Approver
3. View Data Submitter or Search results will be retuned based on the search criteria entered
Approver
4, Click ‘Approval | Submitter or The Approval Status hyperlink will appear next to the Clearing
Status’ Approver Participant record in the Status column within the Search Results
hyperlink pane. Once clicked the Clearing Participant Entity record will be
displayed
5. Commence Submitter The Clearing Participant submitter can commence editing existing
editing information appended against the Clearing Participant
information
against the
Clearing
Participant
Entity
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1.10.2. Clearing Participant Entity Details

Clearing Participant details such as name and address information can be found on the Clearing
Participant Entity Details tab.

Clearing Participant Entity

1D: 296 Workflow Status: Deployed
Clearing Participant Code: CxL
Clearing Participant Legal Name: CXL CP
Exchange: ASX Clear (Futures)
LEL 23323440544
ABN: 44 8588 999 132
Address: 20 Bridge 5t
City / Suburb: Sydney
State: NS E3
Postcode | Zip: 2000
Country: AUSTRALIA [=]

Information that can be amended on this page include the following:

Field Description
LEI Legal Entity Identifier of the Clearing Participant
ABN The Australian Business Number of the Clearing Participant

Field is mandatory

Address The street address of the Clearing Participant.
Use multiple lines as appropriate, i.e.:

Address Line 1: Level 16, Chifley Tower - Field is mandatory
Address Line 2: 2 Chifley Square
Address Line 3: [leave blank]
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Field Description
City / Suburb City / Suburb associated with the street address
Field is mandatory
State Available Australian States where Country has been set to Australia, otherwise
the field is hidden where Country is other than Australia
Postcode / Zip Post Code / Zip associated with the Street Address
Field is mandatory
Country Country associated with the street address
Field is mandatory

1.10.3. Clearing Participant Entity Contacts

Contact details associated with the Clearing Participant are captured on the Clearing Participant

Entity Contacts tab.
Clearing Participant Entity

1D: 250 Workflow Status:

Saved Approval Status: INACTIVE »

~ Legal Contact 1

Job Title: KWY Legal

First Name: Dick

Last Name: Smith

Phone: 405678987

Email: KW @asx.com.au

~ Legal Contact 2

Job Title:
First Name:
Last Name:
Phone:

Email:

~ Operations Contact 1

Job Title: KW OperationContact

First Name: John

Last Name: Dennis

Phone: + (612) 42456813

Email: KWYQOperationContact@asx.com.au

~ Operations Contact 2

Job Title:
First Name:
Last Name:
Phone:

Email:

— Contact in Case of Default 2

~ Contact in Case of Default 1

Job Title: KW contact

First Name: Adam

Last Name: White

Phone: (03) 9874562314

Email: KWYcontact@asx.com.au

Job Title:

First Name:

Last Name:

Phone:

Email:

T T
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Information that can be amended on this page includes the following:

Field Description

Legal Contact Job Title Job Title associated with the Legal Contact 1 and 2

Legal Contact 1 information is mandatory

Legal Contact 1 First Name First Name associated with the Legal Contact 1 and 2

Legal Contact 1 information is mandatory

Legal Contact 1 Last Name Last Name associated with the Legal Contact 1 and 2

Legal Contact 1 information is mandatory

Legal Contact 1 Phone Phone Number associated with the Legal Contact 1 and 2

Legal Contact 1 information is mandatory

Legal Contact 1 Email Email Address associated with the Legal Contact 1 and 2

Legal Contact 1 information is mandatory

Operations Contact 1 Job Title Job Title associated with the Operations Contact 1 and 2

Operations Contact 1 information is mandatory

Operations Contact 1 First First Name associated with the Operations Contact 1 and 2
Name

Operations Contact 1 information is mandatory

Operations Contact 1 Last Last Name associated with the Operations Contact 1 and 2
Name

Operations Contact 1 information is mandatory

Operations Contact 1 Phone Phone Number associated with the Operations Contact 1 and 2

Operations Contact 1 information is mandatory

Operations Contact 1 Email Email Address associated with the Operations Contact 1 and 2

Operations Contact 1 information is mandatory

Contact in Case of Default 1 Job | Job Title associated with the Contact in Case of Default 1 and 2
Title

Contact in Case of Default 1 information is mandatory

Contact in Case of Default 1 First Name associated with the Contact in Case of Default 1 and 2
First Name

Contact in Case of Default 1 information is mandatory

Contact in Case of Default 1 Last Name associated with the Contact in Case of Default 1 and 2
Last Name

Contact in Case of Default 1 information is mandatory
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Field Description
Contact in Case of Default 1 Phone Number associated with the Contact in Case of Default 1
Phone and 2

Contact in Case of Default 1 information is mandatory

Contact in Case of Default 1 Email Address associated with the Contact in Case of Default 1
Email and 2

Contact in Case of Default 1 information is mandatory

© Copyright 2014 ASX Limited ABN 98 008 624 691. All rights reserved 2014 29.



ASX Limited ASX Clear (Futures) Static Data Portal User Manual

1.11. Client Entity Records

1.11.1. Creating a new Client Entity Record

Client Entity records are set up by the ASX upon request from the CP on behalf of their CPM
client. Given some CPM Clients may not wish to disclose details on the form (such as Alternate
Clearing Participant) ASX will also accept forms submitted directly by the CPM Client. In order to
request a new Client Entity to be set up please request your CPM client to fill out the Client Entity
Configuration form in the Appendix. Also in the same section see the User Guide on how to fill this
form out.

Please note: A Clearing Participant user will not have access to the Client Entity record configured
by the ASX in the portal.

1.12. Client Account Records

Details associated with each Client Account are maintained across a number of pages assessable
by tabbed page design layout

| I Address .

Client Account information is associated with the following tabs:

- Details
- Address

1.12.1. Creating a new Client Account

In order to create a new Client Account record, use the following steps:

Step | Action User Description

1. Click ‘Add new Client Account’ | Submitter | This link allows a Clearing Participant user to create a new
link in Navigation bar Client Account.
Add new Client Account

Once clicked, the Client Account tabbed page will be
presented to the user

The following page will then be presented where a Clearing Participant Code / Ledger combination
is required to be appended the Client Account;

Ledger List
Clearing Participant | MAE W
CP Code Ledger
149 MAE SFE Create Client Accounts

In order to create a new Client Account record, use the following steps:

Step | Action User Description

1. Choose a Submitter The Clearing Participant code will be locked to the Clearing
Clearing Participant Code associated with the user logged into system
Participant

Code from the

drop down list The list of Ledgers configured under your Clearing Participant code

will be returned.
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Observe and
choose the
Ledger the you
would like the
Client Account
to be created
under

Submitter

Click the
‘Create Client
Accounts’
button

Submitter

The Clearing Participant Ledger combination is chosen, by clicking
the ‘Create Client Accounts’ button, the system will display the
Client Account Page

Commence
appending
Client Account
Information

Submitter

The Clearing Participant submitter can commence entering
information against the Client Account

1.12.2. Accessing and editing an existing Client Account

Hex

Access to existing Client Account information is via the Record Search page.

B nze Client

Use the following steps to access and edit the information: |

Client Entity

B amp

Australia ..

Client Account Book / Fund
Name
ACTIVE
ACTIVE
ACTIVE
CXLAEDDI CLA_CPS_TD.. ICA ACTIVE
CXLAGOOI CLA_CPS_TD.. ICA ACTIVE
CXLAIDDI  CLA_CPS_TD.. ICA ACTIVE
CXLAKDDI CLA_CPS_TD.. ICA ACTIVE

Step | Action User Description
1. Data Entry Submitter or Enter search criteria to return a Client Account record
Approver
2. Click ‘Search’ | Submitter or
button Approver
3. View Data Submitter or Search results will be retuned based on the search criteria entered
Approver
4, Navigate to Submitter or Navigate through the Client Clearing Account Hierarchy until the
Client Account | Approver relevant Client Account can be located
5. Click ‘Approval | Submitter or The Approval Status hyperlink will appear next to the Client Account
Status’ Approver record in the Status column within the Search Results pane. Once
hyperlink clicked the Client Account record will be displayed
6. Commence Submitter The Clearing Participant submitter can commence editing existing
editing information appended against the Client Account
information
against the
Client Account
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Once saved or submitted, the Client Account code will be automatically generated by the system
on a separate page as follows:

New Client Account created

Client Account Code:

DELAAOOI

1.12.3. Client Account Details

Client Account details such as associated Client Entity, Ledger and Account type etc can be found
onthe Client Account Details tab.

Client Account

1D: 512

Workflow Status: Submitted

Clearing Participant Code:
Client Entity Code:
Client Entity Legal Name:

CXL
DEL
DEL CE Legal Name

Client Account Code: DELAAQOI
Client Account Mame: DEL 1
Client Account Ledger: S5FE
Clearable Products: I;IL :_I -
Eligible Products: Interest Rate Swap
Eligible Currency: AUD
Role: Counterparty
Account Type: ICA
— ldentity details

Inherit Details from Client Entity:

ABHN:

LEI:

Company Registration Mumber: 45200000010
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Information presented to a Clearing Participant user on this screen includes the following:

Field Description

Status The ‘Approved’ status of the Client Account can be amended.

Refer to the following diagram for Approval Status states associated with a Client

Account:
Blank (New
Record)
¥ ¥
<Active Qending
// - This next status will be set by

-

T / e the status assigned to the Client Entity
| Inactive \\\ Hold ‘

SEETNE I

S

Active

¢
'

o
Clearing The Clearing Participant code will be set to the Clearing Participant Firm Code and
Participant cannot be changed
Code

Client Entity The Client Entity is a drop down list of all of the Clients configured in the system
Code

Once the Client Account has been saved into the system, the Client Entity Code
cannot be amended

This field is not required for a Client Account configured as an Omnibus Account and
will be hidden where the ‘Omnibus’ Account Type has been selected

Client Entity The legal name associated with the Client Entity selected. This field is output only and
Legal Name cannot be changed
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Field Description

Client The Client Account code is the unique code associated with the Client Account. The
Account Code | Client Account Code is auto generated by the system for a new record once the
record has been saved or submitted

The Client Account code is an 8 digit auto generated alphanumeric id which can be
broken down into the following components:

- Where the Client Account has been configured as an ICA Account (where
Segregation Code = 1)

Client Account Code = <Client Entity Code (3 Character
Code)><Account Code (2 Character Code)>00<Segregation Code>

Example:
Client Entity Code = DEL

Account Code = AA (the next ICA Client Account for Client Entity DEL will
increment this value to AB)

Level 2 Code = 00
Segregation Code = | (ICA)
= DELAAQO!

Once generated, the Client Account Code cannot be amended

Client The name of the Client Account

Account

Name The Client Account Name cannot be blank

Client The Ledger will be prepopulated with the Ledger chosen from the previous page.
Account This field is output only and cannot be changed

Ledger

Clearable Tick boxes that represent whether the Client Account is required for OTC Client
Products Clearing or Futures Client Clearing.

(OTC &

Futures)

Both tick boxes can be ticked which implies that the Client Account is applied across
both OTC and Futures Client Clearing

Role The role will be set to Counterparty and cannot be changed

Account Type | Account Type can be set to:

- ICA (Individual Client Account)

Please note that Futures Omnibus accounts are not managed within the Static
Data Portal and are managed as per the existing process directly through
Genium.

Once appended, the Account Type cannot be amended
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Field Description

Inherit Details | This tick box will apply the ABN, LEI & Company Registration number fields from the

from Client Client Entity to the Client Account

Entity
Where the Inherit tick box has been ticked, the ABN, LEI and Company Registration
Number fields cannot be amended. Any changes that occur at the associated Client
Entity will be inherited automatically
The Inherit tick box will not be available where the Client Account has been
configured as an Omnibus account

ABN Australian Business Number
The ABN can be applied individually where the Inherit Details from Client Entity tick
box has not been ticked, or automatically where the Inherit Details from Client Entity
tick box has been ticked
An ABN or LEI or Company Registration Number is required to be appended against
the ICA

LEI Legal Entity Identifier
The LEI can be applied individually where the Inherit Details from Client Entity tick
box has not been ticked, or automatically where the Inherit Details from Client Entity
tick box has been ticked
An ABN or LEI or Company Registration Number is required to be appended against
the ICA

Company International Company Registration Number

Registration

Number o Ce .
The Company Registration Number can be applied individually where the Inherit
Details from Client Entity tick box has not been ticked, or automatically where the
Inherit Details from Client Entity tick box has been ticked
An ABN or LEI or Company Registration Number is required to be appended against
the ICA
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1.12.4. Client Account Address

Client Account Address details specifically for the Client Account can be found on the Client
Account Address tab.

Client Account

1D 512 Workflow Status: Submitted

Inherit Details from Client Entity:

Address: 33 Kent Street
City / Suburb: Perth

State: WA

Postcode | Zip: 2001

Country: ALUSTRALLA

Information presented to a user on this screen includes the following:

Field Description

Status The ‘Approved’ status of the Client Account can be amended.

Refer to the following diagram for Approval Status states associated with a Client
Account:

This next status will be set by
the status assigned to the Client Entity
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Field Description

Inherit This tick box will apply the Address details appended against the Client Entity to the
Address from | Client Account

Client Entity

Where the Inherit tick box has been ticked, the Address fields cannot be amended.
Any changes that occur at the associated Client Entity will be inherited automatically

The Inherit tick box will not be available where the Client Account has been
configured as an Omnibus account

Address The street address of the Client Account.
Use multiple lines as appropriate, i..:

Address Line 1: Level 3 <Field is required>
Address Line 2: 20 Bridge St
Address Line 3: [leave blank]

The Address can be applied individually where the Inherit Address from Client Entity
tick box has not been ticked, or automatically where the Inherit Address from Client
Entity tick box has been ticked

City / Suburb | City / Suburb associated with the street address

The City / Suburb can be applied individually where the Inherit Address from Client
Entity tick box has not been ticked, or automatically where the Inherit Address from
Client Entity tick box has been ticked

Field is required

State Available Australian States where Country has been set to Australia, otherwise the
field is hidden where Country is other than Australia

The State can be applied individually where the Inherit Address from Client Entity tick
box has not been ticked, or automatically where the Inherit Address from Client Entity
tick box has been ticked

Postcode / Zip | Post Code / Zip associated with the Street Address

The Postcode / Zip can be applied individually where the Inherit Address from Client
Entity tick box has not been ticked, or automatically where the Inherit Address from
Client Entity tick box has been ticked

Field is required

Country Country associated with the street address

The Country can be applied individually where the Inherit Address from Client Entity
tick box has not been ticked, or automatically where the Inherit Address from Client
Entity tick box has been ticked

Field is required
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2, Contacting Support

21. ASX Online Helpdesk Support
Phone: 1800 682 484

Email: participants.online@asx.com.au

2.2. ASX Clearing Operations
Phone: 1800 240 033 or +612 8298 8479

Email: asxclearfutures@asx.com.au
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3. Appendices

3.1. Appendix 1 — Registration Form

Registration Form for ASX Clear (Futures) Static Data Portal (Clearing Participant or Client)
Administrator user.

Static_Data_Portal_
Registration_Form.pc

3.2, Appendix 2 - Digital Certificate Procedure

To obtain a digital certificate, your Clearing Participant or Client Administrator user must first
create the user in ASX Clear (Futures) Static Data Portal as outlined previously.

After the ASX Online Help Desk has pre-registered the certificate, you will receive an email with
details on how to enrol. The email will be sent to the email address that has been registered in
ASX Online.

Before enrolling and downloading a digital certificate please ensure the following checklist has
been followed:

3.21.  Pre-requisites for Enrolment of a Digital Certificate
e ActiveX Controls set to “Enabled”

e  Onsite MSI package installed for Windows XP Operating System.

3.2.2. Download and Installation of the Root Digital Certificate
e  Click “Install CA” from the Digital Id Centre site? to install the CA.
e Ensure above-mentioned CA has been installed to “Trusted Root Certification Authorities”.
e During installation, select the format ‘My ID for Microsoft Internet Explorer...’

e  Download can only occur once, so the user should not delete their digital certificate.

3 Detailed Instructions and URL to install the root CA is provided in the confirmation email.
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3.23. Enrolment, Downloading and Installation Procedure of the user certificate

The enrolment form is accessed through the Digital ID Centre secure website hosted by VeriSign.
The enrolment website is accessed via:
https://pki.verisign.com.au/services/ASXOperationsPtyLtd/client/userEnrolIMS.htm.

2. When loading the enrolment page for the first time, you will see a Security Warning dialog for
a program digitally signed by Microsoft. This program is required to enrol for a certificate. It is
safe to run it on your computer and its authenticity is proved by a digital signature. Click Yes.

3. The following screen is displayed:

o ASX Enrollment

Complete Enrollment Form

Enter your Digital ID information

Fill ine 3l required fizlds. Fields marked with an asterick [ *) are incleded with yowr Digital 1D and are
wiewsble in the certificate’s details.

First Mame: ¥ [=qu-=c
Nickname or middile initial allowesd
{Example: Jack B.)

Last Mame: * requreo
fescample — Do)

Your E-mail Address: (reguces
{example — jbdoe@ verisign. com)

Passcode: [r=cure

Challenge Phrase

The Chsallenge Fhrase is a unigue phrase that protects you against unsuthorized sction on yowr Digital
ID. Do ot share it with anyone. Do nof Jose if. You will nesd it when you want to revoks or rensw your
Drigitsl 1D

Enter Challenge Phrase: (-=cu-=x
Do mot use any punctustion.

Additional Security for Youwr Private Key
We recommend that you protect the private key associated with youwr digitsl |D. Checking the box
below will provide you with secwrity options for youwr private key. Chck Here for additional information.

Check this Box to Protect Your
Private Key =]

Optional: Enter Comments

In some cases, your administrator will instruct you to enter Shared Secref information (lonown onby to
you and the sdministrator) in this field. The sdministrator uses this d secret to werify that it
realhy is you submitting the application. This comment will not be in in your Digital 1D

-
If all the information abowve is correct,
click Submit to continue,
Cmirans @ SEEoca enSige. e Al P resenes "i VeriSign
A TRUST MO

4. The following fields must be entered exactly as advised by ASX Online Help Desk:
+  First Name
¢+ LastName
+  E-mail Address

+  Passcode?.

4 Provided with the confirmation email
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5. The only field not case sensitive is the Passcode. The Challenge Phrase is a unique phrase
set by the user and not shared with anyone. It might only be needed if a non-Internet
Explorer browser is used for downloading the digital certificate or during certificate renewal.

6. You will be requested to specify the level of security for your Private Key. It is recommended
that High protection is selected for better private key protection.

7. This popup window appears for confirmation of your e-mail address.

Microsoft Internet Explorer 7 x|

D J Confirm your e-mail address:
\.‘\/ jsmith@participant.com

If your e-mail address is correct click OK, if not click CANCEL and
correct it in the enrollment Form.

If the e-mail address is not correct you will not be able to use your Digital ID

A Cancel I

8. If the address is correct, click on OK. The warning window “Web Access Confirmation”

appears.

Potential Saripting Yiolation - |
7 This Web site is requesting a new certificate on your behalf, You should allow only trusted Web sites to request a certificate for you.
. Do you want ko request a certificate now?

9. If you have confirmed that the web site is authentic, click on “Yes” to request the certificate.
The following warning window appears:

Potential Scripting Yiolation E lj

This Wehb site is adding one or more certificates to this computer. allowing an untrusted Web site to update your certificates is a security risk. The Web
!
H site could install certificates you do not trust, which could allow programs that you co not trust to run on this computer and gain access to your data,

Do you want this program to add the certificates now? Click Yes if you trust this \Wea site. Otherwise, click Mo,

10. Click on “Yes” to add the certificate to your computer.
11. After the certificate is successfully installed you should receive a confirmation page

To confirm that the certificate has been successfully installed, open the Internet Explorer browser
and click on: \Tools\Internet Options...\Content\Certificates... and check that the expiration date is
one year in the future. ASX has configured the following policy relating to the Passcode expiry
period and the lockout threshold for invalid entries: The Passcode expiration for enrolment is set to
one month from the date of issue. The lockout threshold is set to three attempts. The fourth invalid
entry will lockout the registration record and will require the ASX to reset the Passcode for the
user.
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Exporting / Importing Procedure

As a digital certificate can only be downloaded from the VeriSign website once, this manual
outlines the steps to export a digital certificate from one PC to another.

This will be required for Business Continuity Processing/Disaster Recovery (BCP/DR) sites where
a certificate will need to be installed on the BCP/DR PC in addition to the normal production PC.

Before importing or exporting a digital certificate please ensure the following checklist has been
followed:

e Private keys must be included in any import or export (i.e. ensure .pfx format is
imported/exported, not .cer).

e  PKCS#12 format must be used (it is specifically designed for private keys).

3.241. Exporting a Certificate

1. In Internet Explorer click on Tools, then Internet Options. Select the Content tab and then
click in the Certificates button.

Internet Options

General | Security || Privacy | Contert | Conmections | Programs | Advanced

Content Advizor

Fiatings help you control the Internet content that can be
@' wiewed on this computer.

Enable
Certificates
% Uze certificates to pozitively identify yourself, certification
@l authorities, and publishers.
[ Clear 551 State l [ LCertificates. .. ] [ Publizhers. .. l

Fersonal information
r, AutoComplete stores previous enties SutoCamplete
and suggests matches for you, =

Micrnmft_meiIe A$$i$tant shores your My Prcfile...
perzonal information.

Ok ] [ Cancel

2. Inthe “Certificates” window select the certificate that you wish to export then click ‘Export’.
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Certificates

Intended purpose: | <all= |

Personal | Gther People | Intermediate Certification Autharities | Trusted Root Certificatior] 4 |* |

| Issued To Issued By Expiratio... | Friendly Name |
| Elasasz00t Training  SFE CA ZBI01J05  <Mone> (W

EacHoz001 Sysadmin  SFE CA 280105 <None>

ElacHoz002 sysadmin  SFE CA 280105 <MNone>

[=EACHOZ003 Syshdmin  SFE CA 23i01j05  <None=

ElacHoz004 Sysadmin  SFE CA 280105 <MNone>

ElacHoz005 Sysadmin SFE CA 280105 <None>

EdacHoz006 Sysadmin  SFE CA Z801j05  <Nonex

ElacLrzo01 Sysadmin - SFE CA 2H01/05  <None>

EacLrz003 Sysadmin - SFE CA 2801j05  <None> ™

[ Irnport. .. ][ Expork... ][ Remove ]

Certificate intended purposes

<hl=

3. The Certificate Export Wizard window then appears. Ensure that you have checked “Yes,
export the private key” then click ‘Next’ to begin the Export.

Certificate Export Wizard @

Export Private kKey
¥ou can choose ko expart the private key with the certificate,

Private keys are password protected. IF wou want ko expart the private key with the
certificate, vou musk bype a password on a later page.

Do o wank ko expork the private key with the certificate?

(&) ¥es, expork the private kevi

()Mo, do not expart the private key

[ < Back, “ Pt = l[ Zancel ]

4. Itis recommended that you Enable strong protection then click ‘Next'.

5. You are required to setup a password to protect the private key. This password will be
required in order to import the certificate.
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Certificate Export Wizard

Export File Format
Certificates can be exported in a warieky of file formats,

Select the Farmat you want ko use:

(%) Personal Information Exchange - PKCS #12 (PR

[ include all certificates in the certification path if possible
Enable strong protection {requires IE 5.0, MT 4.0 5P4 or above)

[ ]Delete the private key i the export is successful

< Back, “ Tk = ][ Zancel

6. Click on the ‘Browse’ button to select the destination for the export of the certificate.
7. Once this has been confirmed, click ‘Next', then click ‘Finish’.

8. A confirmation box will appear confirming that the export was successful.

Certificate Export Wizard

The export was successtul,

3.24.2. Importing a Certificate
1. In Internet Explorer, Click on the ‘Tools’ menu, then ‘Internet Options’.
2. Select the ‘Content’ tab and then click on the ‘Certificates’ button.

3. Inthe Certificates window, click Import.
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Certificates

Intended purpose: : <hll= iva

| Personal | Other People Intermediate Cartification Authorities | Trusted Root CertiFicatio;i[_ ‘,_{_{_!

| 1ssued To Issued By Expiratio,.. | Friendly Name |._"‘|i
[Elasanzo0t Training  SFE CA 280105 <Mane >
ElacHozo01 sysadmin SFE C4 Z8i01/05 =Mone:=
ElacHoz002 Sysadmin SFE CA 2501105 <Mane = |5
ElacHoz00s sysadmin - SFE CA Z8/01/05 =Mone = ‘
ElacHoz004 Sysadmin SFE CA 2501405 “Mane =
ElacHoz005 Sysadmin - SFE CA 280105 <Mane >
ElacHozoos sysadmin - SFE C4 Z8i01/05 =Mone >
ElacLrz0o01 Sysadmin - SFE CA 2801105 <Mane =
Elaclrzo0s syshdmin - SFE CA Z8i01/05 =Mone:= [we]

Certificate intended purposes

Close

>

The Certificate Import Wizard window appears.

o

Please click ‘Next'.

6. Click ‘Browse’ to navigate to the location where the certificate was originally exported to.

‘Certificate Import Wizard

File to Import
Specify the file you want to import.

File name:

Browse...

Note: More than one certificate can be stored in a single file in the following formats:
Personal Information Exchange- PKCS #12 (.PFX,.P12)
Cryptographic Message Syntax Standard- PKCS #7 Certificates (.P7B)

Microsoft Serialized Certificate Store {.SST)

[ < Back ][ Mext > ] [ Cancel ]

7. Please ensure that you change the file type from the default X 509 Certificate to Personal
Information Exchange (*.pfx) in the File of Type drop down box.

8.  Select the certificate that you wish to import and click ‘Open’. Click ‘Next' to proceed.
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My Documents

My Computer

-
Look jn: | (2} Desktop ﬂ D e E
A ‘.DMy Documents
{ ‘) :} My Computer
My Recent ‘:QMV Metwork Places
Documents aPersonal
[ ;~% @test.pfx
Desktop

q File name: ‘ \Z] Open
) — 3
My Network  Files of type: ‘ Personal Information Exchange [*pfx;"p12) EI Cancel

9. You will then be prompted for the password for the private key. This is the same password
that was used when exporting the certificate originally. You are required to enter the

password for the private key and then click ‘Next'.

10. Windows will then allow you to select where you have the certificate stored.

11. Click ‘Next” once completed.

Certificate Import Wizard

Password
To maintain security, the private key was protected with a passward,

Tvpe the password Faor the private key,

Password:

]

[]Enable strang private key protection. You will be prompted every time the
private kev is used by an application if vou enable this option,

[#]Mark this key as expartable. This will allow yau ta back up or transport your
keys at a later kime,

[ < Back, “ et = ][ Cancel

)

12. Click ‘Finish’ to complete the Certificate Import Wizard. A confirmation box will appear

confirming that the import was successful.

F =

Certificate Import Wizard

. | ) The import was successful,
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13. The certificate has now been successfully exported and imported.

3.3. Appendix 3 — Troubleshooting

3.3.1.  Browser-related Error Messages

3.31.1. This website only supports Internet Explorer 7, 8 and 9 Issue

The application will automatically check your browser for compatibility. You will need to try a
different browser version if you try to access the site and get the message.

Please note that the current implementation does not support Internet Explorer 6.

3.31.2. HTTP 403 Forbidden Issue
Why do | get the error message, “HTTP 403 Forbidden™?

This can happen if there is not a valid digital certificate stored on the computer. You can check
your certificate in Internet Explorer by going to Tools-> Internet Options -> Content ->
Certificates>Personal. The certificate issued should match your login name.

r ~
Certificates &J
Intended purpose: [<AJI:= - ]
Persanal |0ﬁ1er People | Intermediate Certification Authorities | Trusted Root Certification * | *

Issued To Issued By Expiratio...  Friendly Name
CRIASXTA UsersName  ASX CA 14062013 <None>
port ) (Gorte ] [ genoe
Certificate intended purposes
<All>
Learn more about certificates

3.31.3. JavaScript Issue

Why do | get the error message, “JavaScript must be enabled to use this site. Please enable
JavaScript in your browser and try again”?

The application checks to see if JavaScript is enabled before it renders the pages in full. If
JavaScript is not enabled, you will not be able to enter any data.

It should be possible to enable JavaScript through the ‘Internet Options>Programs>Manage add-
ons>Toolbars and Extensions section of your browser. Consult Internet Explorer Help for more
information on how to do this for your browser version.
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| General I Security I Privacy I Content I Connections| Programs | Advanced

Default web browser

browser,

@' Internet Explorer is the default web Make default
C

Tell me if Internet Explorer is not the default web browser.,

Manage add-ons

installed in your system.

HTML editing

(-\’ Enable or disable browser add-ons Manage add-ons
-J_
o —

editing HTML files.

Q;F, Choose the program that you want Internet Explorer to use for

HTML editor: [Microsoft Word "]

Internet programs

e-mail.

ﬁ Choose the programs you want to use Set programs

for other Internet services, such as

| ok

| [ cancel || apply ]

It might be necessary to shut down all instances of Internet Explorer before changes take effect.
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3.3.2.  Digital Certificate Issues

Most problems and errors that encountered relating to digital certificates occurred during
enrolment, download, installation and importing and exporting. If several key pieces of information
are known and precautions taken, most of the problems and errors outlined in this document can
be prevented.

Below is a summary of the key information that can prevent most of the problems and errors
occurring.

3.3.21. Issues with Enrolment for a Digital ID:
e  Ensure Check ActiveX Controls are enabled.
o [f operating system is Windows XP, ensure Onsite MSI package is installed.

e  Enrolment can only occur once for each passcode, so ensure details are correct. There are
five fields which are mandatory to be entered (First Name, Last Name, Your E-mail Address,
Passcode and Challenge Phrase). Note that it is not mandatory to check the “Protect Your
Private Key” checkbox or to enter comments. During this process, there are three possible
errors:

e Incorrect Passcode

If invalid username or passcode is entered, then the following error message will be
displayed:

o ASX Error

Passcode Mismatch

Your enrollment failed because you did not supply the correct passcode.

Status Code: 3117

Copyright @ 1988-2004, VariSign, Inc. All rights reserved '. VeriSign
I\ =}

TRUST NETWORK™

e Passcode “Already In Use”

If the passcode selected has already been used to generate a digital id, then the following
error message will be displayed:

QAs Ervor

Passcode Error

Your enrollment failed because the passcode you supplied is already in use for
another enrollment. Please contact your administrator for more information.

Copyright @ 1988-2004, VeriSign, Inc. All rights reserved. ". \ICI'IS]gl'l
h TRUST NETWORK™

e Digital ID Could Not Be Generated

If there is an issue with ActiveX controls for the browser, this error will occur.
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o ASX Error

Digital ID Could Not Be Generated

The most likely reasons for this problem are:

You are using Windows VISTA and have not turned on ActiveX contents. If
you are using Windows VISTA and Internet Explorer 7, "ActiveX Opt-In" feature
on Windows VISTA has disabled ActiveX controls on the system. The page you
want to visit requires your approval to run the ActiveX Control. Please turn on
ActiveX by going to the"Security Settings” tab in the "Internet Options" dialog of
the "View" menu,

You did not choose to run the Enrollment ActiveX control When loading the
enrollment page, you should have seen a "Security Waming" dialog for a program
digitally signed by Microsoft. {(If you did not see this dialog see the next point
below). This program is required to enroll for 3 certificate and is safe to run on
your computer and it's authenticity is proven by the digital signature on the
program which was verified when you saw the dialog.

You may have turned Active Content off. The enroliment page uses an ActiveXx
control to do the certificate request generation. Please turn on ActiveX by going
to the"Security Settings" tab in the "Internet Options" dialog of the "View" menu.
Please set the security settings to "Medium”, which is the Microsoft default
security setting.

You may not have required ActiveX Controls installed. If you are running
Windows 2000 or Windows XP, please ask your system administrator to install
OnSite MSI package for you.

Copyright © 1998-2004, VeriSign, Inc. Al rights reserved ' VeriSign
‘ TRUST NETWORK"

This issue may occur on a XP machine that did not have the required ActiveX Controls
installed. Installation of the Onsite MSI package resolved this issue and allowed the digital
certificate to be downloaded. Please refer to your internal technical support for further
information relating to this.

3.3.2.2, Issues with Download and Installation of a Digital Certificate

e  Ensure user has clicked on “Install CA” from the Digital Id Centre site to install the CA.

e Ensure above-mentioned CA has been installed to “Trusted Root Certification Authorities”.
e During installation, select the format ‘My ID for Microsoft Internet Explorer...’

e Download can only occur once, so the user should not delete their digital certificate.

3.3.23. Issues with Importing and Exporting Digital Certificates

e Private keys must be included in any import or export (i.e. ensure .pfx format is
imported/exported, not .cer).

o  PKCS#12 format must be used (it is specifically designed for private keys).

3.3.24. Digital Download and Installation Issues

Once the user's Digital ID has been generated, it needs to be downloaded and installed on the
user's machine. This process is attempted directly after enrolment.

During this process, there are two errors that are possible.

3.3.2.5. Digital Certificate Could Not Be Installed

This error occurs for a variety of reasons listed below in the error:
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QASX ‘ Error

Digital ID Could Not Be Installed

The most likely reasons for this problem are:

* You may have already installed the Digital ID earlier. Look at the "Personal

Certificates" in the browser's "Options" menu. If you see the Digital ID there, you

need not install it again.

The browser you are using now is not the same one you used when you

enrolled for your Digital ID.You must use the same browser, on the same

computer, to enroll and install your Digital 1D,

A Certificate chain could not be built to a trusted root authority.You do not

have the Root Certificate installed in your system.The Root Certificate has to be

installed in the Certificate Store "Trusted Root Certificate Authority”.

» The URL from which you are trying to enroll is not a Trusted Site. Make the
URL a trusted site by adding the URL name to the list of trusted sites in the
security Tab of the "Internet Options" dialog in the "Tools" menu.

Copyright ® 1998-2004, VeriSign, Inc. All rights reserved. '. Verisign

TRUST NETWORK™

This error occurs because the root certificate has not been installed. By returning to the Digital ID
Centre website: https://pki.verisign.com.au/services/ASXOperationsPtyLtd/digitalidCenter.htm

/& Digital ID Center - Windows Intemet Explorer provided by Australian Securities Exchange.

QQ [ hitps. /pi veris yLtd/digitalid Center htm ~ 7 Symantec Corporation (U] | 1| 5 | ||

i Favorites | 4l ] AEMO Current DispatchL.. £ SFE Business Operations &) Web Slice Gallery ~ [7] Share Paint

& Digital ID Center B8

GASX‘ Digital ID Center
=3 3

ASX Operations Pty. Ltd. Digital ID Center

@ ENROLL
Choose this DDI\DH to enroll for a client D\Q\IE\ ID.

@ PICK UP ID

Choose this option if you enrolled for a Digital ID but did not pick it up.

SEARCH

Choose this option to search for a Digital ID. This function is useful for determining whether
a Digital ID is valid, expired, o revoked. You may also download IDs from this option.

RENEW

Choose this option to renew a Digital 1D which is expiring or which has already expired. You
should generally start renewing your Digital ID at least one month before your Digital ID is
due to expire.

REVOKE

Choose this option ta revoke your Digital ID. Digital IDs should be revoked immediately for
any suspected compromise, including lost o stolen private keys, corrupted key pairs,

change in site ownership, or suspected fraud
< @ INSTALL CA )
R ——

Copuiant © 1955200+, Versign. Ine. All rights reserves r VeriSign

TRUST NETWORK®

And by clicking on “Install CA”, this issue was resolved (note it must be installed in the “Trusted
Root Certification Authorities” store, otherwise the issue will not be resolved).

3.3.2.6. ID Format Unselected

If a user does not select / specify an ID format from the dropdown list, then the following error
message is displayed:
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ASX Error

Digital ID Center

Online Enrollment Status: 8b4c0

If you continue to get this error, and are sure that you entered all of the information,

contact the administrator.

&, WeriSign, Inc. All Rights Reserved

r VeriSign

TRUST NETWORK™

3.3.2.7.

Using Digital Certificates Issues

After a digital certificate has been installed, it can be used to log into ASX Clear (Futures) Static

Data Portal.

Before the ASX Clear (Futures) Static Data Portal website can be opened, it will require the user to
select a digital certificate to use as part of authentication. A list of all available digital certificates
installed on the user's machine will be available to be selected. In the figure below, two digital

certificates are available for selection (User 1 and User 2):

Windows Security

Select a Certificate

User 1
; Issuer: ASX CA
©

Valid From: 11/07/2012 to 12/07/2013
[Click here to view certificate prope...|

User 2

- Issuer: ASX CA
)‘k;»il Valid From: 11/07/2012 to 12/07/2013

| Concel \
3.3.2.8. Digital Certificate Revoked

An “Incorrect Username in the Certificate” error message will be displayed when a user attempts to

log into ASX Clear (Futures) Static Data Portal:
o  When their digital certificate has been revoked.
e Using another person’s digital certificate.

Below is an example of the error message:

@& https:// o - B ~ [ @ v Page~ Safety~

Incorrect Username in the Certificate - O0=ASX Operations Ptyv. Ltd.,
OU=ParticipantID - UBS, OU=Username - User 1
OU=Project - ASXTAOTCDC, CN= yser1
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3.3.3.  Static Data Portal Access Issues

3.3.3.1. Cannot view Static Data Portal link on the application Selection Page.

If the users have valid ASX Online login credentials and valid SSO certificate, they will be able to
access the application selection page. However if they have not been enabled for ASX Clear
(Futures) Static Data Portal they will not be able to view the access link. For any support regarding
Static Data Portal access please contact ASX Clearing Operations.

3.3.3.2, On Clicking the Static Data Portal link, access denied error is displayed

If the users can view the Static Data Portal link on the application selection page, they have been
enabled for ASX Clear (Futures) Static Data Portal. Access denied message on clicking the Static
Data Portal link implies that there is an issue with user’s firm access. The user must follow the
instructions on the screen.

34. Appendix 4 - Client Entity Configuration Form and User Guide

N

Client Clearing Forms  Client Static Data
- Client v0 4.pdf  Forms User Guide v1.
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Disclaimer

This document provides general information only and may be subject to change at any time
without notice. ASX Limited (ABN 98 008 624 691) and its related bodies corporate (“ASX") makes
no representation or warranty with respect to the accuracy, reliability or completeness of this
information. To the extent permitted by law, ASX and its employees, officers and contractors shall
not be liable for any loss or damage arising in any way, including by way of negligence, from or in
connection with any information provided or omitted, or from anyone acting or refraining to act in
reliance on this information. The information in this document is not a substitute for any relevant
operating rules, and in the event of any inconsistency between this document and the operating
rules, the operating rules prevail to the extent of the inconsistency. © Copyright 2014 ASX Limited
ABN 98 008 624 691. All rights reserved 2014.

ASX Trademarks

The trademarks listed below are trademarks of ASX. Where a mark is indicated as registered it is
registered in Australia and may also be registered in other countries. Nothing contained in this
document should be construed as being any licence or right to use of any trademark contained
within the document.

ASX®
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